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Note: the pictures listed in the manual are all examples, please refer to the real 
object. 



1 

Please read this chapter carefully before using this product! 

This chapter introduces the safety precautions before using this product. Please 
make sure the content of this chapter is fully read and understood before installation 
and usage. Our company will not undertake any responsibilities for any damage or 
injury caused by improper operations because of ignoring relevant warning in this 
operation instruction. 

Before operating this device, relevant professional personnel shall read this 
instruction carefully and well understand the content. 

Operation instructions and warnings: 

The following standard definitions will be adopted in this operation instruction. 

Danger! Ignoring of safety precautions may cause personal death, serious personal 
injury or serious equipment damage. 

Warning! Ignoring of safety precautions may cause personal death, serious 
personal injury or serious equipment damage. 

Caution! Ignoring of safety precautions may cause a slight personal injury or 
equipment damage, especially the damage of device or the equipment protected by 
the device. 

 Danger!

When the primary system is live working, secondary open circuit for the current 
transformer connected to the device is absolutely forbidden, and the open of this 
circuit may cause extremely dangerous high voltage. 

 Warning!

Some parts of the device may have high voltage when the electrical device is running. 
Improper operation may cause serious personal injury or equipment damage. 

Only qualified professional personnel are allowed to operate the device or work 
nearby the device. The operators professional shall well understand the precautions, 
working flows and safety regulations mentioned in this instruction. 

 Caution!

Grounding terminals of the device shall be firmly grounded. 

Foreword 
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The device is only permitted to run in atmospheric environment that specified in the 
technical specifications, and abnormal vibrations shall be avoided in its running 
environment. 

When connect the AC voltage current circuit or power circuit, please make sure they 
conform to the rated parameters of the device. 

When the output terminals of the device are connected to external circuit, please 
check carefully the voltage of external power to prevent overheating of the circuit. 

Carefully check the cable connected to the device, preventing applying too much 
external force on it. 
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1.1  Description                                                                                   

RWK-LC overhead line protection switch intelligent controller is medium voltage 
overhead line grid monitoring unit, it can be equipped with RCW(RVB) type vacuum 
circuit breaker for achieve of automatic monitoring, fault analysis and event records. 

Its given to us a safety power grid for cutting line fault and automatic recovery 
operation and power automation.  
RWK-LC series is suitable for up to 35kV outdoor switchgear using, include: vacuum 
circuit breakers, oil circuit breakers and gas circuit breakers.  
RWK-LC intelligent controller is gathering with line protection, control, measurement 
and monitoring of voltage and current signals integrated automation and control 
devices outdoors.  

RWK is an automatic management unit for single way/multi ways/ring network/two 
power sourcing, provided with all voltage and current signals and all functions.  
RWK-LC column switch intelligent controller supports:  
Wireless (GSM/GPRS/CDMA), Ethernet mode, WIFI, optical fiber, power line carrier, 
RS232/485, RJ45 and other forms of communication, and can access other station 
premises equipment (such as TTU, FTU, DTU, etc.). 

1.2  Protection                                                                                   

49  Thermal Overload (Over load) 

50/51  Three-section of Overcurrent (Ph.OC) 

50N/51N Sensitive Earth Fault (SEF) 

27/59  Under/Over Voltage (Ph.OV/Ph.UV) 

51c  Cold load pickup (Cold load) 

1.3  Supervision 

60CTS  CT Supervision 

60VTS  VT Supervision 

1.4  Control 

79  Auto Reclose 

86  Lockout 

                     CB Control 

1.5  Features 

Password Protection – 2 levels. 

50Hz/60Hz systems and two phase/three phase wiring method are available, so that 
the use scope of device is extended. 

Chapter 1: Overview 
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Protection configuration is complete, and all protection functions can be switched on 
and off flexibly. 

4-way intellectual switching value input. 

Large capacity flash memory can record at least 100 times of historical events, and 
no data will loss even the power is off. 

Circuits operating loop can be used both the direct or alternating current, self-
adaptation open/close brake function, which can co-work with various of breakers, 
and the operation is simple and reliable. 

The device has complete self-inspection function to in-service monitor the working 
conditions of various parts of the device, ensuring the reliability of the device.  

1.6  Monitoring Functions 

Primary currents for Phases and Zero sequence current 

Primary PT Voltage 

Frequency 

Binary Input/Output status 

Trip circuit healthy/failure 

Time and date 

Fault records 

Event records 

1.7  Hardware 

3CT  1 VT  4 Binary Inputs   2 Binary Outputs 

1.8  Data Storage and Communication 

RS485, RS232 

Protocols –IEC60870-5-101, IEC60870-5-104, DNP3.0 or Modbus RTU 

Event Records  

Fault Records  

Measurands 

Commands 

Time Synchronism 

Viewing and Changing Settings 
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2.1 Inputs and Outputs       

Phase Current Inputs  

Quantity 3  

Rated Current In 5A 

Measuring Range 20 x In 

Instrumentation≥ 0.1xIn ±1% In 

Frequency 50Hz 

Thermal Withstand: 

Continuous 

10 Second 

1 Second 

 

2 x In 

10 x In 

40 x In 

Burden @ In ≤0.2VA (5A Phase element) 

Sensitive Earth Current Inputs 

Quantity 1 

Rated Current In 5A 

Measuring Range 2 x In 

Instrumentation≥ 0.1xIn ±1% In 

Frequency 50/60Hz 

Thermal Withstand: 

Continuous 

10 Second 

1 Second 

 

2 x In 

10 x In 

40 x In 

Burden @ In ≤0.02VA (1A Earth element) 

Voltage Inputs  

Quantity 1 PT voltage 

Nominal 40…120 Vrms 

Operating Range 0...200 Vrms 

Chapter 2: Technical Performance Index 
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Instrumentation≥0.8xVn ±1% Vn 

Burden @ 110V 0.06 VA 

Overvoltage  Withstand 240 Vrms 

Auxiliary Supply  

DC Voltage 220V  

Range 165 to 265V 

AC Voltage 220 V AC  50Hz 

Range 165 to 350Vrms  AC 

50/60Hz ±5% 

Power consumption ≤10W 

Binary Inputs  

Number 4 

Operating Voltage 24V DC 

Maximum dc current for  operation 2mA 

Binary Outputs  

Number 2 

Operating Voltage 220V DC 

Operating Mode User selectable - Self or 
Hand/Electrical Reset or pulsed 

Operating Time from Energizing Binary 
Input 

<20ms 

2.2  Unit Design  

Indication 16 Character 4 line Display 10 LED’s 

User Interface 11 Navigation Keys 

Weight 18kg 

2.3  Serial Interface       

Communication Port RS485, RS232 

Protocols IEC60870-5-101 

IEC60870-5-104 
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DNP3.0  

MODBUS RTU 

2.4  Data Storage       

Events 100 times 

2.5  Mechanical Tests       

Vibration (Sinusoidal) --- IEC 60255-21-1 Class I 

Type Level Variation 

Vibration  response 0.5gn ≤5% 

Vibration  withstand 1.0gn ≤5% 

Shock and Bump --- IEC 60255-21-2 Class I 

Type Level Variation 

Shock response 0.5gn, 11ms ≤5% 

Shock withstand 15gn, 11ms ≤5% 

Bump test 10gn,16ms ≤5% 

Shock and Bump --- IEC 60255-21- 3 Class I 

Type Level Variation 

Seismic response 

X-plane-3.5mm 

Displacement 

below crossover 

freq (8-9Hz) 1gn 

and above 

Y-plane-1.5mm 

Displacement 

below crossover 

freq (8-9Hz) 

0.5gn above 

≤5% 

Mechanical Classification                  

Durability >106 operations 
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2.6  Electrical Tests       

Insulation --- IEC 60255-5 

Type Level 

Between any terminal and earth 2.0 kV AC RMS for 1 min 

Between independent circuits 2.0 kV AC RMS for 1 min 

Across normally open contacts kV AC RMS for 1 min 

High Frequency Disturbance --- IEC 60255-22-1 Class Ⅲ 

Type Level Variation 

Common (longitudinal) mode 2.5 kV ≤5% 

Series (transverse) mode 1.0 kV ≤5% 

High Frequency Disturbance --- IEC 60255-22-2 Class Ⅳ 

Type Level Variation 

Contact discharge 8.0 kV ≤5% 

Fast Transients --- IEC 60255-22-4 Class A (2002) 

Type Level Variation 

5/50 ns 2.5 kHz repetitive 4 KV ≤5% 

Surge Immunity --- IEC 60255-22-5 

Type Level Variation 

Analog Inputs: 

Line to Earth 

4.0 kV ≤10% 

Case, Aux Power & I/O: Line to Earth 2.0 kV ≤10% 

RS485 Comms port: Line to Earth 1.0 kV No Data Loss 

Analog Inputs: 

Line to Line 

1.0 kV ≤10% 

Case, Aux Power & I/O: Line to Line 1.0 kV* ≤10% 

* Note 45ms DTL pick-up delay applied to binary inputs 
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Conducted Radio Frequency Interference --- IEC 60255-22-6 

Type Level Variation 

0.15 to 80 MHz 10 V ≤5% 

Radiated Radio Frequency --- IEC 60255-25 

Type Limits at 10 m, Quasi-peak 

30 to 230 MHz 40 dB(µV) 

230 to 10000 MHz 47 dB(µV) 

Conducted Radio Frequency              

Type Limits 

Quasi-peak Average 

0.15 to 0.5 MHZ 79 dB(µV) 66 dB(µV) 

0.5 to 30 MHZ 73 dB(µV) 60 dB(µV) 

Radiated Immunity --- IEC 60255-22-3 Class Ⅲ 

Type Level 

80 MHz to 1000 MHz Sweep 10 V/m 

1.4GHz to 2.7GHz Sweep 10 V/m 

80,160,380,450,900,1850,2150 MHz Spot 10 V/m 

2.7  Climatic Tests       

Temperature --- IEC 60068-2-1/2 

Operating Range -10°C  to +55° 

Storage range -25°C  to +70° 

Humidity --- IEC 60068-2-78 

Operational test 56 days at 40°C and 93% 

relative humidity 
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3.1  Function Description 

Under Voltage (Ph.UV) 

The device take the PT voltage as the criterion for under voltage protection.  
Action Logic diagram： 

 

Note: Run is “√”，Stop is “×”. 
UA—Secondary PT voltage   Uset—Pickup voltage   T—Delay time   

Power on  

The device will control the CB to close when the PT voltage greater than pickup 
voltage.  
Action Logic diagram： 

 

Note: Run is “√”，Stop is “×”. 
UA—Secondary PT voltage   Uset—Pickup voltage   T—Delay time   

Over Voltage (Ph.OV) 

The device take the PT voltage as the criterion for over voltage protection. 
Action Logic diagram： 

 

                                                                        Note: Run is “√”，Stop is “×”. 
UA—Secondary PT voltage   Uset—Pickup voltage   T—Delay time   

 

 

Chapter 3: Protection Functionality 
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51c Cold Load Pickup (Cold Load)                    

If a circuit breaker is closed onto a “cold” load, i.e.one that has not been powered 
for a prolonged period, this can impose a higher than normal load-current demand 
on the system which could exceed normal settings. These conditions can exist for an 
extended period and must not be interpreted as a fault. To allow optimum setting 
levels to be applied for normal operation, the cold load pickup feature will apply 
alternative current settings for a limited period. The feature resets when either the 
circuit breaker has been closed for a settable period, or if the current has reduced 
beneath a set level for a user set period. 
Action Logic diagram： 

 

Note: Run is “√”，Stop is “×”. 
I’set—Cold load pickup current   Iset—Ph.OC pickup current   T—Delay time  

50/51 (Ph.OC) 

Three sections phase overcurrent protection for lines include Ph.OC1 (instantaneous 
overcurrent protection), Ph.OC2 (definite time overcurrent protection) and Ph.OC3 
(overcurrent protection). All of which are definite time actuate features.  
Action Logic diagram： 

 

Note: Run is “√”，Stop is “×”. 
IA IB IC—Measured current   Iset—Pickup current   T—Delay time(If the curve type 
is not set to 0, then T is determined by the curve formula)             

50N/51N Sensitive Earth Fault (SEF)       

The sensitive earth fault protection is definite time limit. 
Action Logic diagram： 

  

 Note: Run is “√”，Stop is “×”. 
3I0—SEF current   I0set—Pickup current   T—Delay time  (If the curve type is not set 
to 0, then T is determined by the curve formula)             
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79 Auto - Reclose (Reclose)              

A high proportion of faults on an overhead line network are transient and can be 
cleared quickly by high speed tripping followed by an automated circuit breaker 
reclose sequence. 

The function provides phase fault and earth fault/sensitive earth fault sequences of 
up to 5 trip i.e.4 reclose attempts before lockout, and the charging period of the 
reclose is 10 seconds. 
  
It can cooperate with the curve in P.OC to realize the process of two fast and two 
slow reclosing①.               ①Follow Appendix I 
Action Logic diagram： 

 

Note: Run is “√”，Stop is “×”. 
Reclosing acceleration (Recl.ACC) 

When switching on reclosing acceleration, if accidents happened in 3S after the 
reclose is operated, the phase over current protection will accelerate the operation.  
Action Logic diagram： 

 

Note: Run is “√”，Stop is “×”. 
IA IB IC—Measured current   Iset—Pickup current   T—Delay time   

Manual closing acceleration (Manu.ACC) 

When switching on manual closing acceleration, if accidents happened in the exit 
time after operated the close, the phase over current protection will accelerate the 
operation. The exit time of acceleration can be adjusted. 
Action Logic diagram： 
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Note: Run is “√”，Stop is “×”. 
IA IB IC—Measured current   Iset—Pickup current   T—Delay time    

Prepaid (Optional features) 

It is used to connect the dosing tank, the device will control the CB to trip when the 
dosing tank is in deficit. 
Action Logic diagram：  

 

Note: Run is “√”，Stop is “×”. 
3.2  Constant Value Parameters 

All values are given primary side. 
Under Voltage (Ph.UV) 

Description Setting range Step length 

PH.UV 
Pickup  voltage 0～999.9V 0.1V 
Delay  time 0～99.99S 0.01S 

Power on 

Description Setting range Step length 

Power on 
Pickup  voltage 0~999.9V 0.1V 
Delay  time 0～99.99S 0.01S 

Over Voltage (Ph.OV) 

Description Setting range Step length 

PH.OV 
Pickup  voltage 0~999.9V 0.1V 

Delay  time 0～99.99S 0.01S 

51C Cold Load Pickup (Cold load) 

Description Setting range Step length 

Cold load 
Pickup  current 1～6000A 0.1A 
Delay  time 0～99.99S 0.01S 
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50 Phase Fault (Ph.OC) 

Description Setting range Step length 

PH.OC1 

Curve type 00～10 1 
Pickup  current 00.1～6000A 0.1A 
Time dial 0.00～9.99S 0.01S 
Time adder 00.00～99.99S 0.01S 
Minimum response 00.00～99.99S 0.01S 
Enable end shot 1～5 1 

PH.OC2 

Curve type 00～10 1 
Pickup  current 00.1～6000A 0.1A 
Time dial 0.00～9.99S 0.01S 
Time adder 00.00～99.99S 0.01S 
Minimum response 00.00～99.99S 0.01S 
Enable end shot 1～5 1 

PH.OC3 

Curve type 00～10 1 
Pickup  current 00.1～6000A 0.1A 
Time dial 0.00～9.99S 0.01S 
Time adder 00.00～99.99S 0.01S 
Minimum response 00.00～99.99S 0.01S 
Enable end shot 1～5 1 

50N Sensitive Earth Fault (EF)  

Description Setting range Step length 

EF 

Operating mode Alarm/Trip/Dir trip/Dir alarm(default trip) 
Curve type 00～10 1 
Pickup  current 00.1～999.9A 0.1A 
Time dial 000.0S～600M 0.1S 
Time adder 00.00～99.99S 0.01S 
Minimum response 00.00～99.99S 0.01S 
Start angle 000°～360° 1° 
End angle 000°～360° 1° 

Note: Start and end angle set with zero sequence directional protection 
Description Setting range Step length 

EF2 
Operating mode Alarm/Trip/Dir trip/Dir alarm(default trip) 
Pickup  current 00.1～999.9A 0.1A 
Delay time 000.0S～600M 0.1S 

Note: EF2 is not support directional protection 
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79 Auto - Reclose (Reclose)  

Description Setting range Step length 

Reclose 
Reclose count 1:One  2:Two  3:Three  4:Four 
Delay  time 0～99.99S 0.01S 
Reset  time 1.2～180S 0.1S 

Reclosing acceleration (Recl.ACC)  

Description Setting range Step length 

Recl.ACC 
Pickup  current 0.1～6000A 0.1A 
Delay  time 0～9.99S 0.01S 

Manual closing acceleration (Manu.ACC) 

Description Setting range Step length 

Manu.ACC 
Exit time 0.1～9.99S 0.01S 
Pickup  current 0.1～6000A 0.1A 
Delay  time 0～9.99S 0.01S 

Prepaid (Optional features) 

Description Setting range Step length 

Prepaid Delay  time 0～99.99S 0.01S 
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The operator interface is designed to provide a user friendly method of controlling, 
viewing menus, entering settings and retrieving data from the relay.  11 buttons are 
provided for navigation around the menu structure. 
 
4.1  LEDs    

 

Operation Status 

 

Chapter 4: User Interface 
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LED Categories LED Status 

Name Color ON OFF Flashing 

Run Green crash crash Working 
properly 

DT Green No communication No communication Normal 
communication 

ALM Yellow Device failure or 
protection alarm 

Running normally —— 

ON Red Switch is on Switch is not on —— 

OFF Green Switch is off Switch is not off —— 

ACT Red Protective action No protective 
action 

—— 

79 Red Reclose export Normal —— 

OC Red Over current alarm Normal —— 

SEF Red Ground fault action Normal —— 

86 Red Reclosing lockout 
alarm 

Normal —— 

 
4.2 Keypad 
The main keys 

User actions are mainly concentrated on the operation panel. 
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Key Function 

 
Increase the number 

 
Reduce the number 

 
Move up or page up 

 
Move down or page down 

 

Move left 

 

Move right 

 
Return to the superior or Cancel the operation 

 

Enter the menu of confirm the operation 

When you press the button，the buzzer of device will sing make a sound，so that 
the operation is valid; if not, please do it again. 
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Operation buttons 
Key Function 

 

Touch reset button, you can reset protect information 

 
Touch closing button, close switch 

 
Touch tripping button, trip switch  

When you press the button，the buzzer of device will make a sound，so that the 
operation is valid; if not, please do it again. 

Note: When you press the closing-button or tripping-button, you must make sure the 
device is unlock; if the lockout-light is on, please press the reset-button to reset the 
device, so that you can close or trip the switch. 
 
4.3  LCD                                    

A 4 line by 16 character liquid crystal display with power save operation indicates the 
relay identifier, settings, instrumentation, fault data and control commands.  
 
4.4  The Main Menu 

Press “Enter” when on the main screen, as shown below, including “EDIT” and 
“VIEW” menu item. Select the corresponding menu item with the [←] key, [→] and 
press "Enter" button to enter the corresponding sub-menu, press the “ESC” key to 
return to the previous screen. 

 

Primacy Menu 
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4.5 Submenu 
Edit submenu 

Choose the edit options, the screen will enter the submenu of the Edit menu, as 
shown below, the submenu includes “Relay”、“Para”、“Chnl”、“Clr”、“Time”、

“Comm”、 “Fac”、 “Test”. 

   

Submenu of edit 

 

Enter “Relay” submenu, you can modify the protection 
feature. 

 

Enter “Para” submenu, you can modify or view other 
parameters. Like communication address, baud rate, 
password, trip and close pulse time. 

 

Enter “Adj.” submenu, current and voltage values can be 
corrected, press the function key "Enter" to be modified. 

 

Enter “Clr.” submenu, you can clear out the trip report, the 
alarm report, the SOE report, the count report and all 
report. 

 
Enter the “Time” submenu will modify or check the time. 

 

Enter “Comm” Sub-menu, choose the way to 
communication, it include “GSM”and “GPRS”. 

 

Enter “Fac.” Sub-menu, modify and view the factory 
settings. 

 

Enter “Test” Sub-menu, it can test the life of the switch, 
set the number of reclosing and the interval time of each 
reclosing. 
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View submenu 
Choose the view options, the screen will enter the submenu of the View menu, as 
shown below, the sub-menu includes “Meter”, “RPT”, “Relay”, “Input”, “Ver”. 

  

View submenu 

 

Enter “Meter” submenu, you can view the primary side 
measurement data include: PT voltage, phase current, zero 
sequence current, frequency, phase angle. 

 

Enter “RPT” submenu, you can view trip report, alarm report, 
SOE report, count report. 

 

Enter “Relay” submenu, you can view each protection feature 
is invested and set up the parameters 

 

Enter the “Input” submenu, you can view the input signal. 
The input signal includes: Breaker close, Prepaid open, 
Prepaid close, Spring ready. 

 

Enter “Ver” submenu, you can view the product model, serial 
number and date of manufacture. 

4.6  Entering the password interface 
According to the above operation, before entering each item will first enter a 
password input interface to prevent professional staff misuse. The device original 
password is “0099”, as shown below, press [←] and [→] keys to switch, press the 
[+] and [-] keys to increase and decrease the number of line with the correct 
password press “Enter” button to enter.  

 

Password interface 
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4.7  Relay setting 

Select the “Relay” in the Edit submenu item, press the function key “Enter” to enter 
the password screen, enter the correct password to enter the “Relay” submenu, as  
Shown below, each item has a checkbox and set values. 

 

1. Ph.OC1: Instantaneous overcurrent 
Protection 

2. Ph.OC2: Definite time overcurrent 
protection 

3. Ph.OC3: Overcurrent protection 
4. EF: Earth fault protection 1 
5. EF2: Earth fault protection 2 
6. Cold Load: Cold load pickup 
7. Reclose: OC reclose 
8. Recl.ACC: Reclosing acceleration 

protection 
9. Manu.ACC: Manual closing acceleration 

protection 
10. PH.OV: Overvoltage protection 
12. PH.UV: Low voltage protection 
12. Power on: Power on protection  
13. Prepaid: Debt protection 
14. Power Alm:  Stored energy alarm 

Due to continuous updates, please refer to the actual product for the 
menu！Please refer to Appendix I for other functions. 



25 

 

Three sections phase overcurrent 
Normal overcurrent 

Select Ph.OC menu  option press “Enter” key to enter, operational processes as 
shown below: 

 

Step 1: Setting the overcurrent protection 
current value, the current value can be 
between 0.1A ~ 6000A. 

Step 2: Setting the overcurrent delay time, the 
delay time can be between 0S ~ 9.99S. 

Note: Press [↓] key to switch to next screen, 
press the [+] and [-] keys to switch the 
modified current value and delayed time. 

The operational processes of simple overcurrent protection setting 

Note: Here is a three-stage overcurrent protection period, the use of the other two 
are the same. 
 
Earth fault 

Select EF menu  option press “Enter” key to enter, operational processes as 
shown below: 

 

Step 1: Choose the EF operating mode (1: Alarm 
2: Trip 3: Direction alarm 4: Direction trip). 

Step 2: Setting the EF protection current value, 
the EF current value can be between 0.1A ~ 
999.9A. 

Step 3: Setting the EF delay time, the delay time 
can be between 0 ~ 600.0S/M. 

Step 4: Setting the EF start angle, the angle can 
be between 0 ~ 360°. 

Step 5: Setting the EF end angle, the angle can 
be between 0 ~ 360. 

Note: 1.Press [↓] key to switch to next screen, 
press the [+] and [-] keys to switch the 
modified current value and delayed time. 2. Step 
4 and step 5 only need to be set when zero 
sequence direction overcurrent is required. 

EF2 protection setting is the same as step 1 to 3 
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Cold Load  

Select Cold Load menu  option press “Enter” key to enter, operational processes 
as shown below: 

 

Step 1: Setting the cold load protection 
current value, the current value can be 
between 1A ~ 6000A. 

Step 2: Setting the cold load delay time, the 
delay time can be between 0S ~ 99.99S. 

Note: Press [↓] key to switch to next screen, 
press the [+] and [-] keys to modified 
current value and delayed time. 

 The operational processes of cold load protection setting 

 
Automatic reclosing (Reclose) 

Select Reclose menu  option press “Enter” key to enter, operational processes 
as shown below: 

 

Step 1: Choose the reclosing times (1: One, 
2: Two, 3: Three, 4: Four). 

Step 2: Setting the 1st delay time, the delay 
time can be between 0S ~ 99.99S. 

Step 3: Setting the 2nd delay time, the delay 
time can be between 0S ~ 99.99S. 

Step 4: Setting the 3rd delay time, the delay 
time can be between 0S ~ 99.99S. 

Step 5: Setting the 4th delay time, the delay 
time can be between 0S ~ 99.99S. 

Step 6: Setting the reclosing reset time, the 
reset time can be between 1.2S~ 180.0S. 

Note: Press [↓] key to switch to next screen, 
press the [+] and [-] keys to switch the 
mode and modified delayed time/reset time. 

The operational processes of automatic reclosing setting 
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Reclosing acceleration (Recl.ACC) 

Select Recl.ACC menu  option press “Enter” key to enter, operational processes 
as shown below: 

 

Step 1: Setting the Recl.ACC protection current 
value, the current value can be between 0.1A 
~ 6000A. 

Step 2: Setting the delay time, the delay time 
can be between 0S ~ 9.99S. 

Note: Press [↓] key to switch to next screen, 
press the [+] and [-] keys to switch the 
modified current value and delayed time. 

The operational processes of reclosing acceleration protection setting 

 
Manual closing acceleration (Manu.ACC) 

Select Manu.ACC menu  option press “Enter” key to enter, operational 
processes as shown below: 

 

Step 1: Setting the Manu.ACC exit time, the 
exit time can be between 0.1S ~ 9.99S. 

Step 2: Setting the Manu.ACC protection 
current value, the current value can be 
between0. 1A ~6000A. 

Step 3: Setting the delay time, the delay time 
can be between 0S ~ 9.99S. 

Note: Press [↓] key to switch to next screen, 
press the [+] and [-] keys to switch the 
modified current value and delayed time. 

The operational processes of manual acceleration protection setting 
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Over voltage protection (Ph.OV) 

Select PH.OV menu  option press “Enter” key to enter, operational processes as 
shown below: 

 

Step 1: Setting the Ph.OV protection voltage 
value, the voltage value can be between 0V 
~ 999.9V. 

Step 2: Setting the delay time, the delay time 
can be between 0S ~ 99.99S. 

Note: Press [↓] key to switch to next screen, 
press the [+] and [-] keys to switch the 
modified voltage value and delayed time. 

The operational processes of overvoltage protection setting  

 
Low-voltage protection (Ph.UV) 

Select PH.UV menu  option press “Enter” key to enter, operational processes as 
shown below: 

 

Step 1: Setting the Ph.UV protection voltage 
value, the voltage value can be between 0V 
~ 999.9V. 

Step 2: Setting the delay time, the delay time 
can be between 0S ~ 99.99S. 

Note: Press [↓] key to switch to next screen, 
press the [+] and [-] keys to switch the 
modified voltage value and delayed time. 

The operational processes of low voltage protection setting 
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Power on  

Select Power on menu  option press “Enter” key to enter, operational processes 
as shown below: 

 

Step 1: Setting the Power on protection 
voltage value, the voltage value can be 
between 0V ~ 999.9V. 

Step 2: Setting the delay time, the delay time 
can be between 0S ~ 99.99S. 

Note: Press [↓] key to switch to next screen, 
press the [+] and [-] keys to switch the 
modified voltage value and delayed time. 

The operational processes of Power on protection setting 

 
Prepaid (Optional features) 

Select Prepaid menu  option press “Enter” key to enter, operational processes 
as shown below: 

 

Step 1: Setting the delay time, the delay time 
can be between 0S ~ 99.99S. 

Note: Press the [+] and [-] keys to switch the 
delayed time. 

The operational processes of Prepaid protection setting 
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 4.8  Save parameter  
After setting, press “ESC” key to exit, if modified below figure will show. If you need 
to save press “Enter” key and input password, otherwise press “ESC” key.   

 
4.9  Parameter set 

Press the EDIT → Para, enter the “parameter set”. 

Set the communication parameter 

Name Setting range Step 
length Description 

Comm1 Status 0～1 1 0: Close this channel 
1: Open this channel 

Comm1 Baud 0～38400 1 Default 9600 

Comm1 Protocol 1～4 1 
1: IEC60870-5-101 
2: IEC60870-5-104 
3: DNP3.0 
4: MODBUS 

Comm1 Balance 0～1 1 0: Unbalanced 
1: Balance 

Comm1 Address 1～65535 1 Source address 
Comm1 Report 0～65535 1 Destination address 

Comm1 Upload 0～1 1 0: Do not upload actively 
1: Active upload 

Comm2 Status 0～1(not support) 1 0: Close this channel 
1: Open this channel 

Comm2 Baud 0～38400 1 Default 9600 

Comm2 Protocol 1～4 1 
1: IEC60870-5-101 
2: IEC60870-5-104 
3: DNP3.0 
4: MODBUS 

Comm2 Balance 0～1 1 0: Unbalanced 
1: Balance 

Comm2 Address 1～65535 1 Source address 
Comm2 Report 0～65535 1 Destination address 

Comm2 Upload 0～1 1 0: Do not upload actively 
1: Active upload 

Signal type 1～2 1 1: Single point  
2: Double point 

Control type 1～2 1 1: Single point  
2: Double point 

Meter type 1～4 1 
1: Normalized telemetry 
2: Normalized telemetry without 
quality 

 



31 

 

3: Standardized telemetry 
4: Short floating point telemetry 

Address len 1～2 1 Address length 
1: 1 byte    2: 2 byte 

COT len 1～2 1 COT length 
1: 1 byte    2: 2 byte 

I factor 0.01～100 0.01 Phase current multiplier 
I deadband 0.1～1000 0.1 Phase current dead zone 
I0 factor 0.01～100 0.01 Zero sequence current multiplier 
I0 deadband 0.1～1000 0.1 Zero sequence current dead zone 
U factor 0.01～100 0.01 Line voltage multiplier 
U deadband 0.1～1000 0.1 Line voltage dead zone 
U0 factor 0.01～100 0.01 Zero sequence voltage multiplier 
U0 deadband 0.1～1000 0.1 Zero sequence voltage dead zone 
P factor 0.01～100 0.01 Power multiplier 
P deadband 0.1～1000 0.1 Power dead zone 
COS factor 0.01～100 0.01 COS multiplier 
COS deadband 0.1～1000 0.1 COS dead zone 
OTH factor 0.01～100 0.01 Other multiplier 
OTH deadband 0.1～1000 0.1 Other dead zone 
CLASSA 0～3 1 Class for analog event data 
CLASSB 0～3 1 Class for digital event data 
Select Timeout 0～30 0.1 Select/operate time-out 
Confirm Link 0～1 1 Enable confirm data link 
Link Retry Times 0～15 1 Data link retries times 
Link Timeout 0～50 0.1 Seconds to data link time-out 
Upload Confirm 0～1 1 Enable upload confirmation 
Upload Timeout 0～50 0.1 Seconds to upload time-out 
Upload Retry Times 2～10 1 Upload retries times 
Auto Refresh 0～1 1 Enable automatic reset of events 
Refresh time 0～65535 1 Seconds to automatic reset event 
Check FCB 0～1 1 Check whether the FCB is overturned 

 
Password set 

 

The device initial password is “0099”, 
the password for the user to modify 
from the “0000” ~ “9999”, when revised 
press “Enter” key to confirm, enter the 
password before the modification. 
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CT, CT0 rate set 

 

CT rate is the three phase current rate. 
The value of CT ratio is equal to the 
primary side current value divided by 
the secondary side current value. 

 

CT0 rate is the real zero sequence 
current rate. The value of CT0 ratio is 
equal to the primary side current value 
divided by the secondary side current 
value. 

 
Note:    

1 Different current transformer, CT ratio becomes different, do not modify this 
parameter unless necessary(This parameter has been set before leaving the factory 
and cannot be modified by yourself). 

2 Different current transformer, CT0 ratio becomes different, do not modify this 
parameter unless necessary(This parameter has been set before leaving the factory 
and cannot be modified by yourself). 

Close and trip pulse time set 

 

“Close pulse time” is the discharge time for close coil. “Trip pulse time” is the 
discharge time for trip coil.  

Note: Please do not modify the trip and close pulse time. 

4.10  Calibration 

Select the Edit submenu in “Adj.”, press “Enter” key to enter into the password 
screen, enter the correct password to enter the “Adj.” submenu, press the [+] and [-] 
keys to correct the value of current and voltage.  

Note: All voltage and current values in the factory have been corrected before. 
Please do not change the parameter values. 
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4.11  Clear report 

Select the Edit submenu in “Clr”, press “Enter” key to enter, as shown below: 

 

Select “1”: Clear the trip report. 

Select “2”: Clear the alarm report. 

Select “3”: Clear the SOE report. 

Select “4”: Clear the count report. 

Select “5”: Clear the all report （include trip 
record, alarm record, SOE record and count 
record）. 

 
4.12  Factory setting 

All the values in the factory have been corrected before. Please do not change the 
values. 

4.13  View relay and setting 

Enter the main menu select the “VIEW” option press “Enter” key to enter, and then 
select the “Relay” option to press “Enter” key to enter the “Relay” submenu, you can 

view all the protection is enabled or disabled, select the  option press “Enter” 
key to enter the value you can view each protection, press the arrow keys to switch 
screens. 

 

Due to continuous updates, please refer to the actual product for the 
menu！Please refer to Appendix I for other functions. 
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4.14  View SOE 

Enter the main menu select the “VIEW” option press “Enter” key to enter, and then 
select “RPT” option press “Enter” key to enter the “RPT” submenu, you can view the 
SOE record events, recording events include: trip signal, alarm signal, telemetry 
signal (circuit breaker status, whether the manual or remote operation, fault trip, 
time and date, etc.) and count signal (the count of trip). 

 

 

 
4.14  View input signal 

Enter the main menu select the “VIEW” option press “Enter” key to enter, and then 
select the “Input” option press “Enter” key to enter the “Input” submenu, you can 
view the state of input signal. 

 

 



35 

 

 

Danger: The dangerous voltage with the device maybe result in the permanent 
damage of equipment or personnel casualty during installing RWH-151. These 
voltages mainly distributes at terminal bar of device and circuits of AC current input, 
AC voltage input, digital input, relay output and operation power supply., etc. This 
device’s installation, debugging and maintenance can only be operated by technical 
staff who has been authorized and trained strictly. 

As show below, the installation mode is cabinet door imbedded. The wiring terminal 
wiring comes out of the backboard of the device. 

 

 

 

 

Chapter 5: Installation and Maintenance 
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7.1  Decommission                         

Shut-down Power Supply 

Shut-down Device Power Supply: Turn off external power supply switch of the device. 

Disconnect All Power Cables 

Disconnect all power cables connected to the device. 

Danger: Before disconnecting all power cables connected to the device power 
module, it must confirm that the external power switch is turned off to avoid danger. 

Danger: Disconnecting all power cables connected to the device alternating current 
module, it must confirm that the equipment corresponding to input alternating 
component has stopped operation to avoid danger. 

Dismantle from Display Cabinet 

When the above steps are completed, loosen the fix screws and dismantle the device 
from the display cabinet. 

Danger: When neighboring equipment is in operation, it must strictly confirm the 
safety distance between the dismantled device and other device in operation and 
unskilled professional shall take particular caution. 

7.2  Terminal definition diagram              

 

 

 

Chapter 6: Decommission and Terminal definition diagram 
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The following supplements are provided for additional features： 

 
Overload 

Description Setting range Step length 

Overload 
Operating mode 1.No Dir 2. Alarm 
Pickup current 0.1～6000A 0. 1A 
Delay time 0～99.99S 0.01S 

 

Select overload menu  option press “Enter” key to enter, operational processes 
as shown below: 

 

Step 1: Choose the overload operating mode 
(1. Standard Inverse 2. Very Inverse 3. 
Extremely Inverse). 
Step 2: Setting the overload protection current 
value, the SEF current value can be between 
0.1A ~ 999.9A. 

Step 3: Setting the overload delay time, the 
delay time can be between 0 ~ 600.0S/M. 

Note: 1.Press [↓] key to switch to next 
screen, press the [+] and [-] keys to switch 
the modified current value and delayed time.  

The operational processes of overload protection setting  

 

 

 

 

 

 

 

 

Appendix I: Time-Overcurrent curve and reclose 
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IDMT（51） 

Description Setting range Step length 

IDMT 
Curve mode 1. Standard Inverse 2. Very Inverse  

3. Extremely Inverse 
Pickup current 0.1～6000A 0. 1A 
Time constant 0～99.99S 0.01S 

 

Select IDMT menu  option press “Enter” key to enter, operational processes as 
shown below: 

 

Step 1: Choose the IDMT operating mode (1. 
Standard Inverse 2. Very Inverse 3. Extremely 
Inverse). 
Step 2: Setting the IDMT protection current 
value, the SEF current value can be between 
0.1A ~ 999.9A. 

Step 3: Setting the IDMT delay time, the delay 
time can be between 0 ~ 600.0S/M. 

Note: 1.Press [↓] key to switch to next 
screen, press the [+] and [-] keys to switch 
the modified current value and delayed time. 

The operational processes of IDMT protection setting  

 

51 Inverse Time Overcurrent  

 

TD- Time constant    M-Injuct current/Pickup current   Tp-Delay time 
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